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Enhancements

Enhancements in CIVIL NX 2025 (v1.1)

- Pre & Post processing

1.CQC 3 Directional Combination for Response Spectrum

2.Considering Elastic/General Link Forces in Moving Load Tracer

3.B-double rating vehicle as per AS 5100.7

4.Considering two trucks for substructure members or Elastic/General Link as per AASHTO LRFD Vehicle Loads

5.Moving patch load analysis as per AASHTO LRFD traffic loads

6.IRC Fatigue Vehicle

7.Time Dependent Materials as per  SP/M/022 v 3.4, AS5100.5:2017(Amd 2:2024) and AS3600:2018(Amd 2)

8.Addition of Response Spectrum Function as per DPT.1301/1302-61:2018 and Eurocode Malaysia NA

9.Addition of H and Channel shape section database as per EN 10365

10.Addition of new Design Spectrum Database in Artificial Earthquake Data Generator 

11.Addition of Element Stiffness Scale Factor

- Design

12. RC Design for 1D Beam & Column, Plate Beam & Column as per BS 5400

13. RC & Steel Design as per CSA S6:19

14. Response Modification Factor by members and components as per AASHTO LRFD

15. Addition of an option “Long-term Section Property of Cracked Composite Section: Rebar Area/3” as per AASHTO LRFD



Enhancements

Enhancements in CIVIL NX 2025 (v1.1)

-Including all updates written in the previous pages, and

16. Enhancements in midas GSD

-Prestressed general section check

-Multiple materials for composite section or section rehabilitation

17. Eurocode 22 National Annexes for RC and PSC Design

18. Enhancements in Output Table Performance and Visual Design

19. Updates to Default Settings of the Custom Toolbar

20. Grasshopper Plug-in

21. Excel Add-in with MCT

22. Import and export function in Load Combinations

23. Improvements to Element Color Display for Structural Groups
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1. CQC 3 Directional Combination for Response Spectrum

▪ Load > Dynamic Loads > RS Load Cases

• The CQC3 rule has beendevelopedto estimate the peakvalueof the combinedresponsedue to simultaneousapplicationof the principalcomponentsof groundmotion.

• The user definesthe ratio (γ)of minor to majorspectrum, andthe programfindsthe criticalangle and providesthe maximumresponsefor each component.

Response Spectrum Load Cases

The responses due to vertical ground motion, rz are n
ot included in the CQC3 results.

Major axis, S1

1 and 2: principal axes of ground motion

Minor axis, 
S2 = 0.3S1
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2. Considering Elastic/General Link Forces in Moving Load Tracer

▪ Results > Analysis Result > Moving Tracer > Elastic Link Forces/Moments

▪ Results > Analysis Result > Moving Tracer > General Link Forces/Moments

• Bridge bearingsare oftensimulatedwithElasticLinksor GeneralLinksto representthe stiffness of the bearings.

• Now,Moving LoadTracersupportsElasticLinksand GeneralLinks to find the criticalpositionof the vehicle loads andto convert it into equivalentstatic loads.

Moving Load Tracer
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3. B-double rating vehicle as per AS 5100.7

▪ Load > Moving Load > Moving Load Code : Australia 

• A B-double is definedin the HeavyVehicle NationalLaw (HVNL)as a combinationconsisting of a primemovertowingtwo semitrailers.

• New B-double assessment vehicle DB for Queensland(QLD) and Victoria(VIC) is now available. More than 2 B-double vehicles can be loaded by checking on the option in Moving Load
Analysiscontrol.

Moving Load Cases MB-double VehiclesMoving Load Analysis Control
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4. Considering two trucks for substructure members or Elastic/General Links as per ASHTO LRFD vehicle loads

▪ Load > Moving Load > Lane Support > Lane Support All Forces/Moments

• Although AASHTO LRFD says, "For negative moment between points of contraflexure under a uniform load on all spans, 90 percent of the effect of two design trucks combined with 90

percentof the effect of the design lane load,force componentsother thannegative momentneed to be determinedbasedon the two-truckrule in some projects.

• Now, it is possible to select elementsor linksto applythe two-truckruleto obtain maximumresults for all force components in moving loadanalysis.

Moving Load Tracer
Lane Support

All Forces/Moments

Application of two trucks which gives the maximum a
xial force of the pier.
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5. Moving patch load analysis as per AASHTO LRFD traffic loads

▪ Load > Moving Load (AASHTO LRFD) > Vehicles

• The tire contact areaof a wheelcan be appliedduringmoving loadanalysis. In this version,HL-93TRK, HL-93TDM,and HS20-FTG vehiclesof AASHTO LRFD are only supported.

• The design forces of plate elementscan be noticeablyreducedwith the patch/arealoadscomparedto concentratedwheel loads.

Standard Vehicle
User-Defined Vehicle

Concentrated wheel loads       Patch/area wheel loads
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6. Fatigue Vehicle to IRC 6 : Standard Load

▪ Load > Load Type > Moving Load > Moving Load Code > India

• FatigueVehicle has been added to existingvehicle library of IRC 6 : StandardLoadas per latestamendmentto IRC : 6 FatigueLoadClause204.6.

• For assessment, impactfactorhas been replacedwith surfaceroughness impactdependingupontype of surface.
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6. Fatigue Vehicle to IRC 6 : Standard Load

▪ Load > Load Type > Moving Load > Moving Load Code > India

• The Traffic Lane Definitionsnowinclude an "EJ"checkboxfor specifyingexpansionjoint locations.

• For sections/detailswithin6.0 m of the expansionjoint, the fatigue load arrived as aboveshall further be increasedby a dynamicamplificationfactor, Iej.
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7. Time Dependent Materials as per the latest Australian and New Zealand Standards

▪ Properties > Time Dependent Material > Creep/Shrinkage

▪ Properties > Time Dependent Material > Comp. Strength

• Time Dependent Materials (Creep, Shrinkage and Compressive Strength) as per the following Australian and New Zealand Standards are updated: SP/M/022 v 3.4, AS5100.5:2017(Amd

2:2024)and AS3600:2018(Amd2).

Creep & Shrinkage Compressive Strength
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8. Addition of Response Spectrum Function as per DPT.1301/1302-61:2018 and Eurocode Malaysia NA

▪ Load > Dynamic Loads > RS Functions

• Design Spectrumsfor Thailandspecifications(DPT.1301/1302-61:2018)andEurocodeMalaysianNationalAnnexareadded.

DPT1301/1302-61 Design Spectrum Response Spectrum FunctionMY EN 1998 Design Spectrum



13 / 28

CIVIL NX 2025 (v1.1)  Release NoteCIVIL NX 2025 Pre & Post-Processing

9. Addition of new Design Spectrum Database in Artificial Earthquake Data Generator 

▪ Tools > Data Generator > Artificial Earthquake

• AGS (Artificial Data Generation System for windows) extracts artificial earthquake and design response spectrum using the design spectrum of each standard. Following design spectra are

now added: Taiwan (2022), IS1938(2016), NSR-10, P100-1(2013), NTC 2018, DBWH-LRFD BSDS(2013), AS 5100.2(2017), IRC:SP:114-2018, KBC(2016), China (GB/T 51408-2021), China(JTG/T

2231-01-2020),China(GB50011-2019),China(CJJ166-2011),Japan(Bridge2017),Japan(Bridge2012)

Design Spectrum DB

Artificial Earthquake (RS Spectrum Conversion)

Artificial Earthquake (Time History Acceleration Conversion)
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10. Addition of Element Stiffness Scale Factor

▪ Properties > Section Manager > Element Stiffness Scale Factor

• Apply scale factors to the cross-sectional linear elements (Truss, Tension-only, Compression-only, Cable, Gap, Hook & Beam Elements). Specific stiffness may be reduced such as the case
wherethe flexuralstiffness of girdersin the negativemomentregion may requirereductionto reflectcrackedsections of concrete.

Element Stiffness Scale Factor
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11. RC Design for 1D Beam & Column, Plate Beam & Column as per BS 5400

▪ Design > RC Design > RC Code Design > Beam/Column Design

• Design and checkingof RC frame elementsto BS 5400 are newly introducedinmidas.

• This featurecan be appliedto piersor RC beams.

Design Result Table Detailed Calculation Report
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12. RC Design for 1D Beam & Column, Plate Beam & Column as per BS 5400

▪ Design > RC Design > RC Code Design > Plate Beam/Column Design

• Designand checkingof RC plate elementsto BS 5400 are newly introducedin midas.

• This featurecan be appliedto culvert,pier walls or slabswhere the stressesare distributedin one way.

Plate Beam Design SummaryPlate Beam/Column Design Result Table
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13. RC & Steel Design as per CSA S6:19

▪ Design > RC Design > Design Code Option

• RC memberdesign andsteel memberdesignhave beenupdatedas per CSA S6: 19.

▪ Design > Steel Design > Design Code Option

Steel Design Summary ReportRC Design Summary Report
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14. Response Modification Factor by members and components as per AASHTO LRFD

▪ Design > RC Design > Design Parameters >  Response Modification Factor (R)

• Seismic design force effects for substructuresshall be determinedby dividingthe force effects resultingfromelastic analysisby the appropriateresponsemodificationfactor, R.

• In the previous version, only a single response modification factor could be applied. However, the current version allows for the application of response modification factors based on

substructuretypesand loadcomponents.

• ApplicableCode:AASHTO-LRFD

Response Spectrum Modificatio
n Factor Dialog

Response Spectrum Modificatio
n Factor Table
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15. Addition of an option “Long-term Section Property of Cracked Composite Section: Rebar Area/3” as per AASHTO LRFD

▪ Design > Composite Design > Design Code Option

• In previousversions, the long-termsection propertiesof the composite girdersubjectedto negative momentwerecalculatedas "Steel Section + Long.Reinforcement/3".

• Now,an option is addedto determinethe section propertiesas "Steel Section + Long.Reinforcement".

Composite Steel Girder Design Code Option

Design Report
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Updates in CIVIL NX 2025 (v1.1)
Release Date : Jan. 2025

Product Ver. : CIVIL NX 2025 (v1.1)

Please note that the following features are 
exclusively available in MIDAS CIVIL NX.
Common updates included in CIVIL 2025 
(v1.1) are not detailed in the following 
document.
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16. Enhancements in midas GSD

▪ Apps > General Section Designer

• midas GSD now supports the verification of prestressed concrete sections through P-M interaction curves, Moment-Curvature curves, and Ultimate Limit State (ULS) verification, ensuring
comprehensivedesign validation.

• midas GSD now allows the definition of multiple materials to support the rehabilitation of cross-sections, providing enhanced flexibility and functionality for structural design andanalysis.

• This feature is exclusivelyavailablein MIDAS CIVILNX.

midas GSD
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16. Enhancements in midas GSD

▪ Apps > General Section Designer

• TendonMaterialDB: ASTM, Eurocode,AS/N 4672.1

• NonlinearMaterialProperties:Elastic, Bilinear,Trilinear,User-defined

Tendon Material 
Property

Bilinear Model Trilinear Model User-defined Model
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16. Enhancements in midas GSD

▪ Apps > General Section Designer

• Tendoncoordinates import/exportfrommidasCIVIL

• Effective force is importedintomidas GSD.

Tendon Material Property

Import Tendon from midas Civil Tendon area 
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17. Eurocode 22 National Annexes for RC and PSC Design 

▪ Design > RC Design > Design Code Option

▪ Design > PSC Design > Design Code Option

• The program supports national annexes for RC design and PSC design for the following 22 countries: Austria, Belgium, Cyprus, Czech Republic, Denmark, Finland, France, Germany, Greece,

Ireland,Italy, Luxembourg,Netherlands,Norway,Poland, Romania,Singapore,Slovakia,Slovenia,Spain, Sweden,UK

• This feature is exclusivelyavailablein MIDAS CIVILNX.

Concrete Design Code PSC Design Code
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17. Eurocode 22 National Annexes for RC and PSC Design 

22 National Annexes

Recomm. Austria Belgium Cyprus Czech Denmark
Netherlan

d
Finland France German Greece Ireland Italy

Luxembu

rg
Norway Poland Romania

Singapor

e
Slovakia Slovenia Spain Sweden UK

fck(min) 30 25 25 30 20 unlimited 30 25 20
20(R)

30(P)

25(R)

30(P)
25 25 unlimited 30 30 16 30 30 30 25 25 25

fck(max) 70 60 90 70 90 50 70 unlimited 90 50 50 unlimited 60 90 60 70 50
50 (shear)

70 (other)
70 70 90 100

50 (shear)

70 (other)

fykmax (MPa) 600 600 500 600 600 600 600 700 500 500 500 500 450 600 600 600 500 600 600 600 500 600 600

phimin (mm) 8 12 12 8 12 8 8 8 8 12 8 12 12 8 10 6 12 12 10 12 12 8 12

Alphacc 0.85 0.85 0.85 0.85 0.9 1 1 0.85 1 0.85 0.85 0.85 0.85

0.85(bend

.)

1.00(other

)

0.85 0.85

0.85(90%

↑)

1.0(50%↓)

0.85 0.85 0.85 1 1
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)
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)

Alphact 1 1 1 1 1 1 1 1 1 0.85 1 1 1 1 0.85 1 1 1 1 1 1 1 1
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or 1.25 or

2.5 (1 - σcp

/fcd)

(1 + σcp/fcd

)
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stent or tr
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0.08sqrt(fck

)

/fyk
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0.08sqrt(fck

)

/fyk
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/(7.5∙fyk)
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Beam Rhomin
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0.0013)
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0.0013)
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0.0013)

Rhowmin

(9.2.2(5))

아래 그림 

참고

min(0.26 fct

m/dfy,

0.0013)

min(0.26 fct

m/dfy,

0.0013)

unlimited

min(0.26 fct
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0.0013)
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m/dfy,

0.0013)

min(0.26 fct
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0.0013)
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0.0013)

min(0.26 fct

m/dfy,

0.0013)

Separate 

table

min(0.26 fct

m/dfy,

0.0013)

min(0.26 fct

m/dfy,

0.0013)

Beam Rhomax 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.08 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 0.04 unlimited 0.04

Beam 

Slmax

0.75d(1 + c

otα)

0.75d(1 + c

otα)

<= 250mm

0.75d(1 + c
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0.75d(1 + c
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0.75d(1 + c
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0.75  d (1 + 

cot α)

(h > 250mm

)

0.90d

(h ≤ 250m

m)

Separate 

table

0.75d(1 + c
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0.75d(1 + c
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0.75d(1 + c
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0.75d(1 + c
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400

0.75d(1 + c

otα)

Separate 

table

0.75d(1 + c

otα)

0.75d(1 + c

otα)
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Rhomin

max(0.1NE

d/fyd/Ag, 0.

002)

0.13NEd/fy

d/Ag

≥ 0.0026

max(0.1NE
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max(0.1NE
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d/fyd/Ag, 0.
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max(0.1NE
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max(0.1NE

d/fyd/Ag, 0.
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max(0.1NE
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max(0.15 |

NEd|/fyd/Ag

, 0.003)
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002)
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002)
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003)
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002)

0.2 fcd/fyd

≤ 0.5NEd/fy

d

/Ag ≤ 0.01

max(0.1NE
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004)
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003)
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max(0.1NE

d/fyd/Ag, 0.
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bmin, 300m
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dim, 400m
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17. Eurocode 22 National Annexes for RC and PSC Design 

▪ Crack Width by Exposure Classes

Recommended

Austria

Belgium

Czech

Denmark
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17. Eurocode 22 National Annexes for RC and PSC Design 

Recommended Luxembourg Sweden Germany Czech

▪ Design > RC Design > Design Code Option
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17. Eurocode 22 National Annexes for RC and PSC Design 

▪ Design > PSC Design > Design Code Option

Luxembourg

Czech Norway

Recommended

Sweden
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18. Enhancements in Output Table Performance and Visual Design

• In MIDAS CivilNX 2025, the output table processingtime has beenimproved,achievinga reductionof approximately30% comparedto MIDAS Civil2025.

• Additionally,the table color scheme has beenupdatedto alignwiththe new design frameworkof CivilNX, enhancingvisualconsistency anduser experience.

CIVIL NX 2025 Updates

Test model Type of table
midas Civil

(sec)
MIDAS CIVIL NX

(sec)
Reduced rate(%)

Model 1

Plate forces/moments 198.81 133.95 -0.33

Plane-Stress/Plate Stresses_Plate Force 19.92 12.93 -0.35

Plane-Stress/Plate Stresses_Plate Stress 48.04 31.38 -0.35

Model 2
Beam Forces/Moments 12.76 8.31 -0.35

Beam Forces/Moments_View by Max Value 1258.93 93.15 -0.93

Section Properties Table Load Combinations Dialog Box
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19. Updates to Default Settings of the Custom Toolbar

• The default icons in both the Custom Toolbar and the Vertical Toolbar have been updated to align with those used in the previous version of midas Civil, ensuring a consistent user

experience.

CIVIL NX 2025 Updates
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20. Grasshopper Plug-in

• Users can connect theirRhino+ Grasshopperstructure modelswithMIDAS CIVILNX using the complimentaryMIDAS GH plug-in viaPackage Manager.

• The MIDAS GH providefromgeometrycomponentsto moving load, ConstructionStages, CIVILNX materialandsection database,andmore.

CIVIL NX 2025 Updates
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21. Excel Add-in with MCT

• The users can use theirexisting calculatingsheets using MIDAS CONNECTOR.This Add-inparsingthe datausing APIs, and it is more flexibleto create,modify,and delete components.

• Usage: 1. Select all componentsand connect to MCT_Parsing2. Search Command3. Givea name 4. Select a folder5. Clickaddto Folderbutton, and 6. Pressthe All MXT Exportbutton.

CIVIL NX 2025 Updates
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22. Import and export function in Load Combinations

▪ Results > Load Combinations

• In previous version, load combination data could be imported in *.lcb format, while it was exported in *.lcp format. The difference in file formats and structures between the import and
exportfeaturesmade it challengingto generate loadcombinationsoutsideof the dialogbox.

• In the latestversion,userscan seamlessly importandexport loadcombinations in a uniformMS Excel format,enhancingusabilityandworkflowefficiency.

CIVIL NX 2025 Updates

https://midastech.atlas
sian.net/wiki/spaces/M
SD/pages/71605496/-
+Make+Load+Combinat
ion+Sheet

Load Combinations Dialog Box
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23. Improvements to Element Color Display for Structural Groups

▪ View > Display > Display Option

• In the previous version, when the Element Color option was set to display Structural Group Colors, elements belonging to more than two structural groups were displayed with a single color 

labeled as Duplicated Designation. This often occurred in models containing construction stages or moving load data, where elements were commonly assigned to multiple structural groups.

• In the new version, elements assigned to more than two structural groups will now be displayed based on the following priority:

Priority 1: The structural group with the smallest number of elements among the assigned structural groups.

Priority 2: The structural group listed first in the structural group order.

• This enhancement ensures clearer visualization and improved distinction between overlapping structural group assignments.

CIVIL NX 2025 Updates
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